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1. Введение  
Приложение «3D-Explorer» разработано для визуального представления 

пространственных моделей биологических макромолекул и их комплексов (далее - 
модели). Plan/Protein viewer работает с файлами в PDB-формате. Макромолекула 
может быть представлена в виде скелетной (проволочной), цилиндрической, 
шарнирной (шаростержневой) или полноатомной модели. Модель можно 
перемещать, вращать, отдалять или приближать. В приложении реализованы 
возможности выбора качества изображения, цветовых моделей и отображаемых 
элементов. В приложении реализованы различные виды списков элементов 
модели молекулы, а также отображение структуры молекулы в виде матричной 
диаграммы. 

1.1. Инсталляция  
1.1.1. Инсталляция на Web сервер 

1. перейти в каталог с дистрибутивом  
2. собрать апплет следующей последовательностью команд: 

make clean 
make build 
make install 

3. скопировать jar-файл в нужную директорию Web-сервера 
4. установить программу getfile в каталог cgi-bin Web-сервера 
 

1.1.2. Инсталляция на локальную машину 
Для того чтобы инсталлировать 3D-Explorer на локальную машину, требуется: 

1. инсталлировать JRE 
2. инсталлировать Java3d RE 
3. скопировать jar-файл в нужную пользовательскую директорию 

1.2. Запуск Softberry 3D Explorer (Java версия) 
Запуск Softberry 3D Explorer Java версия можно произвести следующими 

способами: 
 

1. Запуск апплета, который находится на сервере с помощью вставки 
определенного html-кода в html-страницу.  

2. Запуск приложения: 
2.1 Запуск приложения с возможностью работы с Web сервером. 
2.2 Запуск приложения для локальной работы. 

1.2.1. Запуск апплета: 
В html-страницу вставляется следующий html-код: 

 
<APPLET ARCHIVE="proteins.jar" CODE="softberry.project.proteins.Base" 
CODEBASE="/proteins/" WIDTH=10 HEIGHT=10> 
<PARAM name="cgi" value="/cgi-bin/getfile"> 
<PARAM name="data_file" value="/var/www/tmp/java.KHgpna"> 
<PARAM name="help" value="/proteins/help/prot_hlp.html"> 
</APPLET> 
 

Где: 
ARCHIVE – имя файла, где лежит архив с исполняемым кодом апплета.  
CODE – базовый класс апплета. 
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CODEBASE – каталог на web-сервере, где лежит архив с исполняемым кодом 
апплета. 

WIDTH – ширина апплета на экране броузера (internet-browser) в пикселах 
(меньше 10 ставить не рекомендуется). 

HEIGHT  - высота апплета на экране броузера (internet-browser) в пикселах 
(меньше 10 ставить не рекомендуется).  

PARAM – некоторый парметр апплета. Его атрибуты: 
name -  имя параметра.  

  value – значение параметра.  
Параметров может быть несколько. Есть два обязательных параметра для 

запуска 3D-Explorer: 
1. name=“cgi”. Его значением является относительный URL на cgi-bin 

файл (сервер данных и запросов). Без правильного указания 
данного параметра апплет работать не будет.  

2. name=“data_file”. Его значением является относительный URL на  
файл с данными в специальном формате (см. п. 1.3). Без 
правильного указания данного параметра апплет работать не 
будет.  

3. name=“help”. Его значением является относительный URL на файл 
документации. Без правильного указания этого параметра справка 
будет недоступна. 

 
 

1.2.2. Запуск приложения 
 
Общий вид запуска приложения выглядит следующим образом: 
java –mx500 –cp “PATH_TO_JAR”proteins.jar softberry.project.proteins.Base 
[web options] 

1.2.2.1. Запуск приложения для работы с Web сервером 
Команда для запуска: 
java –mx500 –cp “PATH_TO_JAR”proteins.jar softberry.project.proteins.Base [–c 
getatoms_cgi] [-get getfile_cgi]  [-cce ce_cgi] [-sQH sQH_cgi] [-host host][-
port port] 
 

Значение параметра –host определяет Web сервер, через который будет 
осуществляться обращение к серверному приложению. Это обязательный 
параметр для работы c Web сервером. 

Значение параметра –port определяет порт для работы с Web сервером. 
Это не обязательный параметр. Значение по умолчанию 80. 

Значение параметра –c определяет относительный URL серверного 
приложения getatoms. Путь к серверному приложению указывается относительно 
Web сервера. Без правильного указания данного параметра будет недоступна 
возможность работы с Getatoms 

Значение параметра –get определяет относительный URL серверного 
приложения getfile. Путь к серверному приложению указывается относительно 
Web сервера. Это обязательный параметр, для возможности работы с Web 
сервером. 
 

1.2.2.1. Запуск приложения для локальной работы 
Команда для запуска: 
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java –mx500 –cp “PATH_TO_JAR”proteins.jar softberry.project.proteins.Base 
 
 

1.2.3. Форматы данных при работе с Web сервером 
 

1.2.3.1. Формат данных для загрузки с сервера 
 
STRUCTURE__ 
[Список структур, может быть пустым. Одна строка – одна структура. Строка 
имеет вид: 
file structureId 
где 
file –имя файла с PDB данными на сервере (относительно корня Web сервера) , 
structureId -  идентификатор структуры] 
__STRUCTURE 
 
 ALIGNMENT__ 
[Список выравниваний, может быть пустым. Одна строка соответствует одному 
выравниванию. Строка имеет вид: 
structure1 chain1 structure2 chain2 file 
где 
structure1 – иденитификатор первой структуры в выравнивании (должен совпадать 
с одним из блока STRUCTURE), 
chain1 – цепь для первой структуры, 
structure2 – иденитификатор второй структуры в выравнивании (должен совпадать 
с одним из блока STRUCTURE), 
chain2 – цепь для второй структуры, 
file –имя файла с выравниванием на сервере (относительно корня Web сервера)  
(описание формата в п. 1.3.2.). 
] 
 __ALIGNMENT 
 
Пример: 
/******Example start here**************/ 
STRUCTURE__ 
  /var/www/tmp/prot.CgqAd5 1hba 
  /var/www/tmp/prot.CgqAd6 1hbb 
__STRUCTURE 
ALIGNMENT__ 
  1hba B 1hbb A /var/www/tmp/prot.CgqAd7 
__ALIGNMENT 
/******Example end here**************/ 
 

1.2.3.2. Формат выравнивания 
 
HEADER__ 
SOURCES__ 
FILE1: - файл с первой структурой 
FILE2: - файл со второй структурой 
CHAIN1: идентификатор первой цепи 
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CHAIN2: идентификатор второй цепи 
SIZE1: длина первой цепи (вместе с гэпами) 
SIZE2: длина второй цепи (вместе с гэпами) 
__SOURCES 
__HEADER 
ALIGNMENT__ 
Строки выравнивания,  в таком виде: 
{Position on sequence1} {aligned sequence1 segment} 
{Position on sequence2} {aligned sequence2 segment} 
__ALIGNMENT 
 
Пример: 
 
/******Example start here**************/ 
HEADER__ 
SOURCES__ 
FILE1: /usr1/apache/tmp/cce.zjmRVT 
FILE2: /usr1/apache/tmp/cce.cnHbQL 
CHAIN1: B 
CHAIN2: A 
SIZE1: 146 
SIZE2: 141 
__SOURCES 
__HEADER 
ALIGNMENT__ 
2 HLTPEEKSAVTALWGKV--NVDEVGGEALGRLLVVYPRTQRFFESFGDLSTPDAVMGNPKVKAHGKKVLG 
1 VLSPADKTNVKAAWGKVGAHAGEYGAEALERMFLSFPTTKTYFPHFDL------SHGSAQVKGHGKKVAD 
 
70 AFSDGLAHLDNLKGTFATLSELHCDKLHVDPENFRLLGNVLVCVLAHHFGKEFTPPVQAAYQKVVAGVAN 
65 ALTNAVAHVDDMPNALSALSDLHAHKLRVDPVNFKLLSHCLLVTLAAHLPAEFTPAVHASLDKFLASVST 
 
140 ALAHKYH 
135 VLTSKYR 
__ALIGNMENT 
/******Example end here**************/ 
 
 

1.3. Загрузка приложения 
Во время загрузки на фоне главного окна появляются информационные 

окна, сообщающие о текущих этапах загрузки и обработки данных (рис. 1.3.1).  
Если размер загружаемой молекулы превышает рекомендуемый, 

появляется диалоговое окно “Model options, с помощью которого можно сократить 
количество отображаемых элементов (описание диалога см в п. 3.5 «Выбор 
отображаемых элементов модели»). 
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Рисунок 1.3.1. 
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2. Общее описание системы 
2.1. Главное окно 

Главное окно содержит (рис. 2.1.1): 
• Главное меню 
• Панель управления  
• Главная область отображения молекулы 
• Вспомогательная область отображения молекулы 
• Информационная панель 
• Строка статуса 
 

Главное окно 

Рисунок 2.1.1. 
1. Главное меню. 2. Панель управления. 3. Главная область отображения модели. 
4. Вспомогательная область отображения модели. 5. Информационная панель. 
6. Строка статуса. 

2.2. Команды главного меню  
Меню File  – содержит одну команду:  

• Exit – выход из программы 
 
Меню View  – содержит набор команд, предназначенных для работы с 
изображением модели: 

• Delail level  – установить уровень качества изображения: 
o Very low  – очень низкое качество. 
o Low  – низкое качество. 
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o Normal  – нормальное качество. 
o High  – высокое качество. 
o Very high  – очень высокое качество. 
o Custom – качество, заданное пользователем (данный параметр 

задается в диалоговом окне настроек “Options”). 
• Display style – вызывает диалоговое окно “Display options”, 

предназначенное для настройки геометрии и цветовых схем модели. 
• Light options – вызывает диалоговое окно “Light options”, 

предназначенное для настройки освещения модели. 
• Сolors - вызывает диалоговое окно “Periodic table”, предназначенное 

для выбора цветов отображения химических элементов.  
• Model options – вызывает диалоговое окно “Model Options”, 

предназначенное для выбора отображаемых типов атомов, цепей, 
аминокислотных остатков и химических элементов. 

• Options  – вызывает диалоговое окно “Options”, предназначенное для 
настройки общих параметров отображения и степени 
чувствительности к движению мыши. 

 
Меню Window  – содержит набор команд, предназначенных для выделения 
элементов модели: 

• Tree dialog  – вызывает диалоговое окно “Tree dialog”, предназначенное для 
отображения иерархической структуры элементов модели. 

• Sequence viewer  – вызывает диалоговое окно “ Sequence viewer”, 
предназначенное для отображения аминокислотных последовательностей 
цепей. 

• Matrix dialog  – вызывает диалоговое окно “Matrix”, предназначенное для 
отображения структуры молекулы в виде матричной диаграммы. 

 
Меню  ? – содержит одну команду: 

• Help – вызывает руководство пользователя. 
• About – вызывает диалоговое окно “About” с информацией о программе 

(рис. 2.2.1). 
 

 

 
Рисунок 2.2.1. 

 

2.3. Панель управления  
Кнопки панели управления и их функции: 
 

 “Display options” - вызывает диалоговое окно “Display options”, 
предназначенное для настройки геометрии и цветовых схем модели. 
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Действует аналогично команде View>Display style главного меню. 
 “Light options”   - вызывает диалоговое окно “Light options”, предназначенное 

для настройки освещения модели. Действует аналогично команде 
View>Light options главного меню. 

 “Color options”   - вызывает диалоговое окно “Periodic table”, 
предназначенное для выбора цветов отображения химических элементов. 
Действует аналогично команде View>Сolors главного меню. 

 “Reset model position”  – восстанавливает позицию модели, заданную при 
загрузке.  

 “Fit model to screen”  – масштабирует модель по размерам области 
отображения. 

 “Select rotation center mode”  – включает режим, при котором можно выбрать 
атом, вокруг которого будет вращаться модель. 

 “Reset rotation center”  – устанавливает центр вращения в геометрический 
центр модели. 

 “Select mode on/off”  – включение/выключение режима выделения.  

 “Normal selection mode”  – включить режим, при котором предыдущее 
выделение меняется на новое. 

 “OR selection mode”  – включить режим, при котором новое выделение 
добавляется к предыдущему. 

 “XOR selection mode”  – включить режим, при котором инвертируется 
выделение элементов, попавших в область нового выделения.  

 “Inverse selection”  – инвертировать выделение. 

 “Select all”  – выделить все элементы модели. 

 “Unselect all”  – снять выделение со всех элементов модели. 

 “Model options” - вызывает диалоговое окно “Model Options”, 
предназначенное для выбора отображаемых типов атомов, цепей, 
аминокислотных остатков и химических элементов. Действует аналогично 
команде View>Model options главного меню. 

 “Options”  – вызывает диалоговое окно “Options”, предназначенное для 
настройки общих параметров отображения и степени чувствительности к 
движению мыши. Действует аналогично команде View>Options главного 
меню. 

 “Tree model dialog”  – вызывает диалоговое окно “Tree dialog”, 
предназначенное для отображения иерархической структуры элементов 
модели. Действует аналогично команде Window>Tree dialog главного меню. 

 “Sequence viewer”  – вызывает диалоговое окно “Sequence viewer”, 
предназначенное для отображения аминокислотных последовательностей 
цепей. Действует аналогично команде Window>Sequence viewer главного 
меню. 

 “Matrix viewer”  – вызывает диалоговое окно “Matrix”, предназначенное для 
отображения структуры молекулы в виде матричной диаграммы. Действует 
аналогично команде Window> Matrix dialog главного меню. 

 “Help”  – вызывает руководство пользователя. Действует аналогично 
команде ?>Help главного меню. 

 
Примечание. Если навести курсор на кнопку панели управления, в строке статуса 
главного окна отобразится название функции выбранной кнопки (рис. 2.1.1). 
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2.4. Области отображения модели  
На главной области отображается модель в выбранном режиме 

отображения, на вспомогательной – схематичное изображение модели. 
Вспомогательная область предназначена для изменения позиции модели и 
расстояния до нее. На вспомогательной области быстрее осуществляются 
движение, вращение и изменение расстояния до модели, что важно при работе с 
моделями, содержащими большое количество атомов. Результаты действий, 
произведенных над изображением модели на вспомогательной области, 
применяются к изображению модели на главной области и наоборот. 

Цвет фона областей отображения можно изменить с помощью диалогового 
окна “Options” (см п. 3.6). 

Границы между областями отображения и информационной панелью 
можно изменять с помощью мыши. 

2.4.1. Контекстное меню  
Для того чтобы вызвать контекстное меню (рис. 2.4.1), щелкните правой 

кнопкой мыши на главной области отображения. Контекстное меню содержит 
следующие команды: 
• “Select atom”  – выделить атом. Выделяется последний атом, на который был 

наведен курсор.  
• “Select residue”  – выделить остаток. Выделяется последний остаток, на 

который был наведен курсор.  
 

Контекстное меню области отображения 

 
Рисунок 2.4.1. 

 
•  “Select chain”  – выделить цепь. Выделяется последняя цепь, на которую был 

наведен курсор.  
• “Select molecule”  – выделить молекулу.  
• “Select all”  – выделить все элементы модели. 
• “Unselect atom”  – снять выделение с атома. 
• “Unselect residue”  – снять выделение с остатка. 
• “Unselect chain”  – снять выделение с цепи. 
• “Unselect molecule”  – снять выделение с молекулы. 
• “Unselect all”  – снять выделение со всех элементов молекулы. 

2.5. Информационная панель  
 На информационной панели (рис. 2.1.1) отображаются: 
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• Данные об атоме, на который наведен курсор: имя атома, название 
химического элемента, номер атома, название цепи и остатка, к которым 
принадлежит данный атом. 

• Данные об участке вторичной структуры модели: название остатка, на 
который наведен курсор, название цепи и тип вторичной структуры.  

2.6. Строка статуса  
Строка статуса (рис. 2.1.1) предназначена для отображения текущей 

информации. В ней отображаются: название функции кнопки панели управления, 
на которую в данный момент наведен курсор, текущий режим работы мыши, 
текущий уровень детализации и информация о выделении. 
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3. Работа с системой 
3.1. Работа с изображением. 
3.1.1. Настройка изображения  

3.1.1.1. Настройка качества изображения 
Изменить качество изображения  можно двумя способами: 
• Командой View>Detail level главного меню: 

o Very low  – очень низкое качество. 
o Low  – низкое качество. 
o Normal  – нормальное качество. 
o High  – высокое качество. 
o Very high  – очень высокое качество. 
o Custom  – качество, заданное пользователем (данный параметр 

задается в диалоговом окне “Options”, описание диалога см в п. 3.6). 
• Путем изменения значения параметра “Detail level” в диалоговом окне 

настроек “Options” (см п. 3.6). 

3.1.1.2. Настройка вида модели 
Диалоговое окно “Display options”  можно вызвать: 
• Командой View>Display style главного меню. 
• Кнопкой  панели управления.  

Окно содержит две вкладки: “Atom” и “Protein”. 
Вкладка “Atom”   

На вкладке “Atom” (рис. 3.1.1.2.1) можно установить параметры 
отображения атомов модели: 
Панель “Display style”   позволяет выбрать вид модели или выделенного участка 
модели: 

• “Off”  – отключить изображение атомов.  
• “Line”  – проволочная (скелетная) модель. Связи между атомами 

отображаются линиями.  
• “Stick” – цилиндрическая модель. Связи между атомами 

отображаются цилиндрами. Диаметр цилиндров задается в поле 
“Stick size”. 

• “Ball and Stick” – шарнирная схема. Атомы отображаются сферами, 
связи между атомами – цилиндрами. Диаметр цилиндров задается в 
поле “Stick size”, радиус сфер – в поле “Ball size”. 

• “CPK”  – полноатомная модель (space-filling). Радиусы сфер 
пропорциональны вандерваальсовым радиусам атомов. Масштаб 
сфер задается в поле “CPK scale”. 

 
Панель “Color”  предназначена для выбора цветовой схемы, применяемой к 
изображению атомов.  

При выборе опции “Scheme” становится активным список, содержащий 
следующие цветовые схемы: 

• “By Element”  – цвет атома определяется химическим элементом. 
• “By Chain”  – цвет атома определяется цепью, к которой он принадлежит. 
• “By Residue”  – цвет атома определяется остатком, к которому он 

принадлежит. В этом случае под остатком подразумевается любая группа 
ковалентно связанных атомов (аминокислотные остатки, нуклеотиды, 
гетерогруппы). 
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• “By Amino Acid”  – цвет атома определяется аминокислотой, к которой он 
принадлежит. 

• “By Structure” – цвет атома определяется структурой, к которой он 
принадлежит. 

• “By Groups” – цвет атома определяется его принадлежностью либо к 
основной цепи белка либо к боковым цепям.   
При выборе опции “Custom” становится активной цветная кнопка, 

предназначенная выбора пользовательского цвета модели или выделенного 
участка модели. При нажатии цветной кнопки вызывается диалоговое окно “Color 
dialog” (см п. 3.7), в котором можно выбрать новый цвет. 
 

Диалоговое окно “Display options”. Вкладка “Atom” 

 
Рисунок 3.1.1.2.1. 

1. Панель выбора вида модели. 2. Панель выбора цветовой схемы. 3. Поле ввода 
диаметра цилиндров. 4. Поле ввода радиуса сфер для шарнирной модели. 
5. Поле ввода масштаба сфер для полноатомной модели. 6. Кнопка закрытия окна 
и применения выбранных установок. 7. Кнопка закрытия окна и отмены выбранных 
установок.. 8. Кнопка применения выбранных установок без закрытия окна. 
 

Вкладка “Protein”   
На вкладке “Protein” (рис. 3.1.1.2.2) можно установить параметры 

отображения модели, специфичные для белковой молекулы. Опции вкладки 
“Protein” применяются только к целой цепи.  

Примечание. Если среди выделенных элементов модели есть хотя бы 
одна целая цепь, вкладка активна. Если выделены не все дочерние элементы 
цепи (т.е. цепь выделена частично), вкладка “Protein” неактивна. Если одна цепь 
выделена полностью, а другая цепь –  частично, опции вкладки будут применены 
только к цепи, которая выделена полностью. 
Панель “Display style” позволяет выбрать вариант отображения цепей: 

• “Off”  – отключить изображение. При выборе этой команды цепи не 
отображаются. 

• “CA Wire”  – Сα-атомы вдоль цепи соединены линиями. 
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• “CA Stick”  – Сα-атомы вдоль цепи соединены цилиндрами. Диаметр 
цилиндров задается в поле “Stick size”. 

• “Line ribbon” – молекула белка отображается в виде линий, 
соответствующих ходу основной цепи. 

• “Flat ribbon”  – молекула белка отображается в виде плоской ленты, 
соответствующей ходу основной цепи. 

• “Solid ribbon”  – молекула белка отображается в виде объемной 
ленты, соответствующей ходу основной цепи. 

• “Schematic” – структура молекулы представлена в виде следующей 
схемы: α-спирали отображаются в виде широких цилиндров,  β-листы 
– в виде стрелок, переходы, повороты и неизвестные структуры – в 
виде узких цилиндров (трубок). 

 
Диалоговое окно “Display options”. Вкладка “Protein” 

 
Рисунок 3.1.1.2.2. 

1. Панель выбора вида отображения белковой цепи. 2. Панель выбора цветовой 
схемы. 3. Поле ввода диаметра цилиндров для опции “CA Stick”. 4. Флаг, 
отключающий отображение атомов модели. 5. Кнопка закрытия окна и 
применения выбранных установок. 6. Кнопка закрытия окна и отмены выбранных 
установок. 7. Кнопка применения выбранных установок без закрытия окна. 
 
Панель “Color” предназначена для выбора цветовой схемы, применяемой к 
изображению цепей.  

При выборе опции “Scheme” становится активным список, содержащий 
следующие цветовые схемы: 

• “By Chain”  – каждая цепь окрашивается своим цветом. 
• “By Residue”  – цвет участка цепи зависит от цвета остатка. В этом случае 

под остатком подразумевается любая группа ковалентно связанных атомов 
(аминокислотные остатки, нуклеотиды, гетерогруппы). 

• “By Amino Acid”  – цвет участка цепи зависит от цвета аминокислоты. 
• “By Amino Acid Hydrophobicity”  – цвет участка цепи определяется его 

гидрофобными свойствами. 
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• “By Amino Acid pKa”  - цвет участка цепи определяется величиной константы 
pKa аминокислоты. 

• “By Structure” –  цвет участка цепи определяется структурой, к которой он 
принадлежит.  

• “By Secondary structure” – цвет участка цепи зависит от вторичной структуры 
этого участка. Красным цветом выделяются α-спиральные участки, синим –  
β-структурные, белым – повороты и неструктурированные участки. 

Примечание. При выборе режимов “Flat ribbon” и “Solid ribbon” автоматически 
устанавливается цветовая схема “By Secondary structure”. 

При выборе опции “Custom” становится активной цветная кнопка, 
предназначенная выбора пользовательского цвета модели. При нажатии цветной 
кнопки вызывается диалоговое окно “Color dialog” (см п. 3.7), в котором можно 
выбрать новый цвет. 

Флаг “Hide atoms”.  Если флаг установлен, отображение атомов модели 
отключается. 

Примечание. Кнопка «OK» служит для закрытия окна и применения 
выбранных установок, кнопка «Apply» - для применения выбранных установок без 
закрытия диалогового окна, кнопка «Cancel» служит для закрытия окна и отмены 
выбранных установок. 

3.1.2. Настройка освещения модели 
 Диалоговое окно “Light options”   (рис. 3.1.2.1) можно вызвать:  

 
Диалоговое окно настроек освещения молекулы 

 
Рисунок 3.1.2.1. 

1. Ползунки. 2. Верхний левый источник. 3. Нижний левый источник. 4. Верхний 
правый источник. 5. Нижний правый источник. 6. Фронтальный источник. 
7. Контровой источник. 8. Кнопка закрытия окна и применения выбранных 
установок. 9. Кнопка закрытия окна и отмены выбранных установок.  

 
• Командой View>Light options главного меню.  
• Кнопкой   панели управления 

В приложении реализовано шесть стандартных источников освещения, которые  
включаются следующими флагами:  

• Top-Left  – источник света установлен слева над моделью. 
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• Bottom-Left   – источник света установлен слева под моделью. 
• Top-Right  – источник света установлен справа над моделью. 
• Bottom-Right  – источник света установлен справа под моделью. 
• Front  – фронтальный – источник света установлен перед моделью. 
• Back  – контровой – источник света установлен позади модели. 

Интенсивность источников освещения настраивается с помощью ползунков.  
3.1.3. Настройка цветов химических элементов 

Изменять цвета отображения химических элементов можно с помощью 
диалогового окна “Periodic Table”   (рис. 3.1.3.1), которое можно вызвать: 

• Командой View>Colors главного меню.  
• Кнопкой   панели управления 
 

Диалоговое окно выбора цвета атомов  

Рисунок 3.1.3.1. 
1. Кнопки, предназначенные для настройки отображения химических элементов. 
2. Кнопка закрытия окна и применения выбранных установок. 3. Кнопка 
применения выбранных установок без закрытия окна. 4. Кнопка возврата 
стандартных значений вандерваальсовых радиусов элементов и цветов по 
умолчанию.  
 

Окно содержит цветные кнопки, предназначенные для настройки 
отображения химических элементов. Цвет кнопки соответствует цвету 
отображения химического элемента. 

При нажатии цветной кнопки для соответствующего элемента вызывается 
диалоговое окно, заголовок которого содержит название элемента, например, 
“NITROGEN”   (рис. 3.1.3.2):  
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• Кнопка “Color” окрашена в текущий цвет отображения элемента. При нажатии 
этой кнопки вызывается диалоговое окно “Color dialog” (см п. 3.7), в котором 
можно выбрать новый цвет. После выбора нового цвета кнопка окрасится в 
выбранный цвет. После нажатия кнопки “OK” окно закрывается, а в диалоговом 
окне “Periodic Table” цвет кнопки с названием химического элемента изменится 
на новый цвет. 

• Поле “VDW radius” содержит стандартное значение вандерваальсова радиуса 
элемента. Это значение может быть изменено пользователем. После нажатия 
кнопки “OK” в данном диалоге и последующего нажатия кнопки “Close” или 
“Apply” в диалоговом окне “Periodic Table” модель будет перерисована с учетом 
заданного значения. 

 
Кнопки управления диалоговым окном “Periodic Table”: 

• “Close” – кнопка закрытия окна и применения выбранных установок.  
• “Apply” – кнопка применения выбранных установок без закрытия окна. 
•  “Reset” – кнопка возврата стандартных значений вандерваальсовых радиусов 

элементов и цветов по умолчанию. 
 

Диалоговое окно настроек отображения азота 

 
Рисунок 3.1.3.2. 

1. Кнопка, предназначенная для настройки цвета химического элемента. 2. Поле, 
предназначенное для изменения значения вандерваальсова радиуса элемента.  
3. Кнопка подтверждения выбора. 4. Кнопка отмены выбора. 
 

3.2. Движение модели 
3.2.1. Перемещение модели  

Перемещение изображения молекулы по области отображения 
производится мышью с нажатой клавишей “Ctrl”.  

3.2.2. Вращение модели  
Вращение модели производится с помощью мыши.  
По умолчанию модель вращается вокруг своего геометрического центра. 

Для того, чтобы выбрать атом, вокруг которого будет вращаться молекула, нужно: 
1. Включить режим выбора центра вращения кнопкой   панели управления. 
2. Щелкнуть мышью на атоме, вокруг которого будет вращаться молекула. 
3. Отключить режим выбора центра вращения кнопкой  панели управления. 

 Чувствительность вращения к движению мыши регулируется в диалоговом 
окне “Options” (см п. 3.6). 

3.2.3. Изменение расстояния до модели 
Расстояние до модели меняется мышью с нажатой клавишей “Shift”. Если 

курсор двигается вниз, расстояние до модели увеличивается, вверх – 
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уменьшается. Чувствительность изменения расстояния к движению мыши 
регулируется в диалоговом окне “Options” (см п. 3.6). 

Примечание. Для того чтобы вернуть модель к первоначально загруженному 
положению, нужно нажать кнопку   панели управления. 

Примечание. Для того чтобы масштабировать модель в область отображения, 
нужно нажать кнопку   панели управления. 

3.3. Выделение элементов модели 
Выделение элементов на областях отображения молекулы производится с 

помощью мыши. Режим выделения включается кнопкой   панели управления.  
При нажатой кнопке  становятся активными кнопки, которые 

активизируют разные режимы выделения: 
 – “Normal selection mode”  – включить режим, при котором предыдущее 

выделение меняется на новое. 
 – “OR selection mode”   – включить режим, при котором новое выделение 

добавляется к предыдущему. 
 – “XOR selection mode”  – включить режим, при котором инвертируется 

выделение элементов, попавших в область нового выделения. 
 
Кнопка   инвертирует выделение.  
Кнопка    служит для выделения всех элементов модели. 
Кнопка    служит для снятия выделения со всех элементов модели. 

3.4. Списки элементов модели 

3.4.1. Иерархический список элементов модели 
 Диалоговое окно “Tree dialog”   (рис. 3.4.1.1), предназначенное для 
отображения иерархической структуры элементов модели, можно вызвать: 

• Командой Window>Tree dialog главного меню 
• Кнопкой   панели управления. 

Окно содержит следующие элементы: 
• Панель управления 
• Список элементов модели 
• Кнопки управления диалоговым окном. 

Функции элементов панели управления 
Кнопка . При нажатии кнопки список раскрывается до уровня молекулы. 
Кнопка . При нажатии кнопки список раскрывается до уровня цепей 
Кнопка . При нажатии кнопки список раскрывается до уровня остатков 
Кнопка . При нажатии кнопки список раскрывается до уровня атомов 
Кнопка .   При нажатии кнопки включается режим, при котором предыдущее 
выделение меняется на новое. Выбор элементов производится либо щелчком 
мыши на элементе, либо выделением прямоугольной области курсором.  
Кнопка .   При нажатии кнопки включается режим, при котором новое 
выделение добавляется к предыдущему. Выбор элементов производится либо 
щелчком мыши на элементе, либо выделением прямоугольной области курсором. 
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Кнопка .   При нажатии кнопки включается режим, при котором инвертируется 
выделение элементов, попавших в область нового выделения. Выбор элементов 
производится либо щелчком мыши на элементе, либо выделением прямоугольной 
области курсором. 
Кнопка .  При нажатии кнопки выделение инвертируется. 
Кнопка .   При нажатии кнопки выделяются все элементы списка 
Кнопка .  При нажатии кнопки отменяется выделение всех элементов списка 
Кнопка . При нажатой кнопке выделение элементов сразу же применяется к 
изображению модели на областях отображения, а кнопки “Apply” и “Cancel” 
становятся неактивными. Если кнопка отжата, выделение применяется только 
после нажатия кнопки “OK” или “Apply”. 
 

Диалоговое окно “Tree dialog ” 

 
Рисунок 3.4.1.1. 

1. Панель управления. 2. Список элементов модели. 3. Кнопка выхода из окна и 
применения выделения. 4. Кнопка применения выделения без выхода из окна. 
5. Кнопка выхода из окна отмены выделения.  
 

Список элементов модели 
 Список элементов модели содержит иерархическую структуру модели, 
представленную в виде дерева. Выделение элементов списка производится с 
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помощью мыши. Режимы выделения и уровень иерархии списка регулируются 
кнопками панели управления. 
 Узлы, содержащие, по меньшей мере, один выделенный дочерний элемент, 
помечаются зеленым цветом. 
 Выделенные элементы помечаются синим цветом. Если выделены все 
дочерние элементы узла, он помечается синим цветом. Если выделен узел, его 
дочерние элементы помечаются синим цветом.  

Кнопки управления диалоговым окном 
• Кнопка «OK» служит для применения выделения при закрытии окна. 
• Кнопка «Apply» служит для применения выделения без закрытия 

диалогового окна.  
• Кнопка «Cancel» служит для отмены выделения. 

3.4.2. Отображение аминокислотных последовательностей цепей 
 Диалоговое окно “Sequence viewer”, предназначенное для отображения 
списка аминокислотных последовательностей цепей, можно вызвать: 

• Командой Window> Sequence viewer главного меню 
• Кнопкой   панели управления. 

3.4.2.1. Строение диалогового окна 
 Окно содержит: 
• Панель управления 
• Область отображения последовательностей 
• Кнопки управления диалоговым окном 
• Срока статуса 

Панель управления 
Функции элементов панели управления: 
Кнопка  (Normal selection mode). При нажатии кнопки включается режим, при 
котором предыдущее выделение меняется на новое. Выбор элементов 
производится либо щелчком мыши на элементе, либо выделением прямоугольной 
области курсором.  
Кнопка  (OR selection mode). При нажатии кнопки включается режим, при 
котором новое выделение добавляется к предыдущему. Выбор элементов 
производится либо щелчком мыши на элементе, либо выделением прямоугольной 
области курсором. 
Кнопка  (XOR selection mode). При нажатии кнопки включается режим, при 
котором инвертируется выделение элементов, попавших в область нового 
выделения. Выбор элементов производится либо щелчком мыши на элементе, 
либо выделением прямоугольной области курсором. 
Кнопка  (Rectangle area selection mode). При нажатии кнопки включается режим, 
при котором при движении курсора выделяются остатки, попавшие в 
прямоугольную область. 
Кнопка  (Lines selection mode). При нажатии кнопки включается режим, при 
котором  при движении курсора выделяются остатки, попавшие в строки. 
Кнопка  (Columns selection mode). При нажатии кнопки включается режим, при 
котором  при движении курсора выделяются остатки, попавшие в столбцы. 
Кнопка  (Options). Вызывает диалоговое окно настроек (см п. 3.4.2.2) диалога 
“Sequence viewer”. 
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Кнопка  (Hide or show elements). Вызывает диалоговое окно “Visible and hidden 
elements”, предназначенное для включения и выключения из отображения 
моделей  на области отображения цепей (см п. 3.4.2.3). 
Кнопка  (Hide or show headers of elements). При нажатой кнопке над 
последовательностями цепей отображается название модели. 
Кнопка  (Select all). При нажатии кнопки выделяются все элементы списка 
Кнопка  (Deselect all). При нажатии кнопки отменяется выделение всех 
элементов списка 
Поле ввода предназначено для поиска фрагмента (шаблона) в цепях. Введите 
последовательность в поле и нажмите кнопку “Enter”. Найденный фрагмент будет 
выделен цветом (рис. 3.4.2.1). 
 

Диалоговое окно “Sequence viewer” 

 
Рисунок 3.4.2.1. 

1. Панель управления. 2. Найденный фрагмент. 3. Область отображения 
последовательностей. 4. Остаток, на который наведен курсор на области 
отображения модели. 5. Название модели. 6. Идентификаторы цепей. 7. Срока 
статуса.   8. Кнопка закрытия окна и применения выбранных установок. 9. Кнопка 
применения выбранных установок без закрытия окна. 10. Кнопка закрытия окна и 
отмены выбранных установок. 
 

Область отображения последовательностей.  
 Область содержит последовательности цепей в однобуквенном коде 
(рис. 3.4.2.1). На данной области производится выделение остатков. Режимы 
выделения задаются в диалоговом окне настроек (см п. 3.4.2.2) и на панели 
управления, цветовая разметка - в диалоговом окне настроек (см п. 3.4.2.2). Цвет 
фона области задается в диалоговом окне настроек (см п. 3.4.2.2). Красный 
подчерк под остатком означает, что он входит в состав α−спирали, синий – в 
состав β-структуры.  
 В левой части области находятся идентификаторы цепей, включенных 
для отображения. Названия цепей, содержащих вновь выделенные остатки, 
помечаются цветом (цвет настраивается в диалоговом окне настроек). Цвет фона 
названий задается в диалоговом окне настроек. Если щелкнуть мышью на 
названии цепи, выделится вся ее последовательность. 
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 Остаток, на который наведен курсор на области отображения модели, 
выделяется цветом (рис. 3.4.2.1). 

Кнопки управления диалоговым окном: 
o “OK” - кнопка закрытия окна и применения выбранных установок.  
o “Cancel” - закрытия окна и отмены выбранных установок.  
o “Apply” - кнопка применения выбранных установок без закрытия окна.  

Срока статуса. 
 В строке статуса отображается: 
• Информация об остатке, на который наведен курсор: название остатка в 

трехбуквенном коде и его номер в PDB-файле (рис. 3.5.2.1). 
• Название кнопки панели управления, на которую наведен курсор. 
 

Диалоговое окно настроек   
 Диалоговое окно настроек выделения содержит две вкладки. Вкладка 
“Common” предназначена для общих настроек окна и режимов выделения. 
Вкладка “Colors” предназначена для настройки цветовой разметки выделения 
аминокислот списка. 

Вкладка “Common”   
• Панель “Selection mode” предназначена для выбора режима выделения: 

o Опция “Normal”. Если опция выбрана, включается режим, при 
котором предыдущее выделение меняется на новое. 

o Опция “XOR”. Если опция выбрана, включается режим, при котором 
инвертируется выделение элементов, попавших в область нового 
выделения. 

o Опция “OR”. Если опция выбрана, включается режим, при котором 
новое выделение добавляется к предыдущему.  

• Панель “Selection style” предназначена для выбора стиля выделения на 
области отображения аминокислотных последовательностей: 

o Опция “Rectangle”. Если опция выбрана, при движении мыши 
выделяется прямоугольная область. Выделяются все остатки, 
попавшие в эту область. 

o Опция “Rows”. Если опция выбрана, при движении мыши на остатке 
выделяется вся строка, к которой принадлежит данный остаток. 

o Опция “Cols”. Если опция выбрана, при движении мыши на остатке 
выделяется весь столбец, к которому принадлежит данный остаток. 

• Флаг “Select after mouse release only”. В данной версии неактивен. 
• Флаг “Show horizontal grid”. Если флаг установлен, на области отображения 

аминокислотных последовательностей отрисовываются горизонтальные 
разделительные линии. Если флаг выключен, горизонтальные разделительные 
линии не отрисовываются. 

• Флаг “Show vertical grid”. Если флаг установлен, на области отображения 
аминокислотных последовательностей отрисовываются вертикальные 
разделительные линии. Если флаг выключен, вертикальные разделительные 
линии не отрисовываются. 

• Флаг “Leave partial selection during apply”. Если флаг установлен, частичное 
выделение аминокислот сохраняется при применении нового выделения. 

• Кнопка “Font” служит для установки шрифта названий цепей и аминокислотных 
последовательностей. При нажатии кнопки вызывается диалоговое окно “Font”, 
предназначенное для выбора шрифта (п. 3.9). 
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Настройки режимов выделения 

 
Рисунок 3.4.2.2.  

1. Панель выбора режима выделения. 2. Панель выбора стиля выделения. 3. 
Флаг, устанавливающий немедленное применение выбранных настроек. 4. Флаг, 
устанавливающий горизонтальную сетку. 5. Флаг, устанавливающий 
вертикальную сетку. 6. Флаг, устанавливающий сохранение частичного 
выделения. 7. Кнопка, предназначенная для настройки шрифта. 8. Кнопка выхода 
из окна и применения выбранных установок. 9. Кнопка выхода из окна и отмены 
выбранных установок. 10. Кнопка применения выбранных установок без закрытия 
окна. 
 
 

Вкладка “Colors”  
• Панель “Background color” предназначена для выбора цвета фона области 

отображения аминокислотных последовательностей. Цвет кнопки отображает 
текущий цвет. При нажатии кнопки вызывается диалоговое окно выбора цвета 
“Color dialog”, с помощью которого можно установить нужный цвет. Работа с 
диалогом описана в п. 3.7. 

• Панель “Applied selection color” предназначена для выбора цвета примененного 
выделения остатков. Цвет кнопки отображает текущий цвет. При нажатии 
кнопки вызывается диалоговое окно выбора цвета “Color dialog”, с помощью 
которого можно установить нужный цвет. Работа с диалогом описана в п. 3.7. 

• Панель “Partial selection” предназначена для выбора цвета остатка, который 
выделен частично (т.е. не все атомы которого были выделены). Цвет кнопки 
отображает текущий цвет. При нажатии кнопки вызывается диалоговое окно 
выбора цвета “Color dialog”, с помощью которого можно установить нужный 
цвет. Работа с диалогом описана в п. 3.7. 
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• Панель “Chain background” предназначена для выбора цвета фона области 
отображения названий цепей. Цвет кнопки отображает текущий цвет. При 
нажатии кнопки вызывается диалоговое окно выбора цвета “Color dialog”, с 
помощью которого можно установить нужный цвет. Работа с диалогом описана 
в п. 3.7. 

• Панель “User selection color” предназначена для выбора цвета нового 
выделения. Цвет кнопки отображает текущий цвет. При нажатии кнопки 
вызывается диалоговое окно выбора цвета “Color dialog”, с помощью которого 
можно установить нужный цвет. Работа с диалогом описана в п. 3.7. 

 
Цветовые настройки 

 
Рисунок 3.4.2.3. 

1. Панель выбора цвета фона области отображения аминокислотных 
последовательностей. 2. Панель выбора цвета нового выделения. 3. Панель 
выбора цвета примененного выделения. 4. Панель выбора цвета пересечения 
примененного и нового выделений. 5. Панель выбора цвета частичного 
выделения. 6. Панель выбора цвета пересечения частичного и нового выделений. 
7. Панель выбора цвета фона области отображения названий цепей. 8. Панель 
выбора цвета названий цепей, содержащих выделенные элементы. 9. Панель 
предварительного просмотра. 10. Кнопка выхода из окна и применения 
выбранных установок. 11. Кнопка выхода из окна и отмены выбранных установок. 
12. Кнопка применения выбранных установок без закрытия окна. 
 
• Панель “Selection of applied” предназначена для выбора цвета остатков, 

которые попадают в пересечение примененного и нового выделений. Цвет 
кнопки отображает текущий цвет. При нажатии кнопки вызывается диалоговое 
окно выбора цвета “Color dialog”, с помощью которого можно установить 
нужный цвет. Работа с диалогом описана в п. 3.7. 
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• Панель “Selection of partial” предназначена для выбора цвета остатка, который 
попадает в пересечение частичного и нового выделений. Цвет кнопки 
отображает текущий цвет. При нажатии кнопки вызывается диалоговое окно 
выбора цвета “Color dialog”, с помощью которого можно установить нужный 
цвет. Работа с диалогом описана в п. 3.7. 

• Панель “Selected chains” предназначена для выбора цвета названий цепей, 
содержащих выделенные остатки. Цвет кнопки отображает текущий цвет. При 
нажатии кнопки вызывается диалоговое окно выбора цвета “Color dialog”, с 
помощью которого можно установить нужный цвет. Работа с диалогом описана 
в п. 3.7. 

• Панель “Preview” предназначена предварительного просмотра выбранных 
цветовых настроек. 

 
Кнопки управления диалоговым окном: 

• “OK” - кнопка применения настроек с закрытием окна.  
• “Cancel” - кнопка отмены.  
• “Apply” - кнопка применения настроек без закрытия окна.  

3.4.2.3. Диалоговое окно “Visible and hidden elements”. 
 Диалоговое окно “Visible and hidden elements” (рис. 3.4.2.3.1) вызывается 
кнопкой  панели управления окна “Sequence viewer”.  В данном окне 
регулируется состав и порядок расположения моделей и выравниваний на 
области отображения последовательностей окна “Sequence viewer”. 

Для того чтобы включить в отображение модели (и выравнивания), 
необходимо выполнить следующие действия. 

1. Выделить идентификаторы моделей и выравниваний в списке «Hidden» 
щелчком мыши (снятие пометки на идентификаторе осуществляется 
повторным щелчком мыши на нем). 

2. Нажать кнопку . При этом выделенные идентификаторы переместятся 
из списка «Hidden»  в конец списка «Visible». Идентификаторы 
переместятся в том порядке, в котором они находились в списке «Hidden». 

Для того чтобы включить в отображение все модели (и выравнивания), нужно 

нажать кнопку . Все идентификаторы переместятся из списка «Hidden» в 
список «Visible» в том порядке, в котором они были в списке «Hidden». 

Для того чтобы исключить модели из отображения, необходимо выполнить 
следующие действия: 

1. Выделить необходимые идентификаторы моделей и выравниваний в списке 
«Visible» щелчком мыши (снятие пометки на идентификаторе 
осуществляется повторным щелчком мыши на нем). 

2. Нажать кнопку . При этом выделенные идентификаторы переместятся 
из списка «Visible»  в конец списка «Hidden». Идентификаторы 
переместятся в том порядке, в котором они находились в списке «Visible» . 

Для того чтобы исключить из отображения все модели (и выравнивания), нужно 

нажать кнопку . Все идентификаторы переместятся из списка «Visible» в 
список «Hidden» в том порядке, в котором они были в списке «Visible». 

 
Для того чтобы изменить порядок отображения моделей, воспользуйтесь 

кнопками смещения вверх (кнопка “Up”) и вниз (кнопка “Down”). При нажатии на 
кнопки будет производиться смещение выделенных идентификаторов на одну 
позицию в соответствующем направлении.  
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Диалоговое окно “Visible and hidden elements”. 

 
Рисунок 3.4.2.3.1. 

1. Кнопка смещения выбранных моделей вверх. 2. Кнопка смещения выбранных 
моделей вниз.  3. Кнопки управления списками “Visible” и “Hidden”. 4. Список 
“Visible”. 5. Список “Hidden”.  6. Кнопка закрытия окна и применения выбранных 
установок.  7. Кнопка применения выбранных установок без закрытия окна. 8. 
Кнопка закрытия окна и применения отмены установок. 

 
 

Кнопки управления диалоговым окном. 
• Кнопка “OK” служит для закрытия окна и применения выбранных установок.   
• Кнопка “Cancel” служит для закрытия окна и отмены выбранных установок.  
• Кнопка “Apply” служит для применения выбранных установок без закрытия 

окна. 
 

3.5. Выбор отображаемых элементов  
Выбрать отображаемые атомы, цепи, остатки и химические элементы 

можно с помощью диалогового окна “Model options”   (рис. 3.5.1), которое можно 
вызвать: 

• Командой View>Model options главного меню. 
• Кнопкой   панели управления. 

На справочной панели отображается текущая информация для всех 
загруженных моделей и для модели, выбранной в выпадающем списке:  

1. суммарные количества цепей, остатков и атомов, содержащихся в 
моделях и количество включенных в отображение атомов.  

2. количество атомов,  выбранных для отображения.  
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Диалоговое окно настроек отображения модели молекулы 

 
Рисунок 3.5.1. 

1. Справочная панель. 2. Панель выбора отображаемых элементов белка. 3. 
Панель выбора отображаемых элементов ДНК. 4. Панель вызова списков 
отображаемых элементов модели. 5. Список загруженных моделей. 6. Кнопка 
выхода из окна и подтверждения выбора. 7. Кнопка выхода из окна отмены 
выбора. 

 
Список идентификаторов моделей служит для выбора модели, для которой 

можно изменить параметры отображения.   
 
Панель “Proteins”  служит для выбора отображаемых элементов белка: 
Флаг “Protein backbone” Если флаг установлен, отображается основная 

цепь белка. Способы отображения цепи: 
• Trace -  выделяются только Cα- атомы белка. 
• Partial - выделяется часть атомов основной цепи белка: Cα, N и C. 
• Complete - выделяются все атомы основной цепи белка: Cα, N, C и O. 

Флаг “Protein sidechains”.  Если флаг установлен, отображаются боковые 
цепи белка. 
 
Панель “DNA” служит для выбора отображаемых элементов ДНК: 
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Флаг Nucleotide backbone.  Если флаг установлен, отображается 
сахарофосфатный остов ДНК. 

Флаг Nucleotide bases. Если флаг установлен, отображаются нуклеотидные 
основания. 

 
Флаг «Solvents». Если флаг установлен, отображаются атомы 

растворителя. 
Флаг «Heterogenes». Если флаг установлен, отображаются гетероатомы. 
 
Кнопки “Atoms”, “Chains”, “Residues”, “Elements” и “Models” вызывают 

соответствующие диалоговые окна со списками отображаемых атомов, цепей, 
остатков, химических элементов и моделей  (рис. 3.5.2). 

 
 

В диалоговых окнах “Atoms”, “Chains”  и “Models” (3.5.2 A, C, D, E) 
необходимо выделить отображаемые элементы или модели. Для этого требуется 
щелкнуть мышью на индикаторе состояния, расположенном слева от названия 
элемента. Если на индикаторе появился черный квадрат ( ), элемент выбран для 
отображения, иначе ( ) – исключен из отображения (рис. 3.5.2).  

В диалоговом окне “Atoms” кнопки панели управления над списком 
позволяют включать в отображение следующие группы атомов: 

• Кнопка  –  все атомы списка. 

• Кнопка  – атомы основной цепи белка: Cα, N, C и O. 
• Кнопка   – часть атомов основной цепи белка: Cα, N и C. 
• Кнопка  – только Cα- атомы основной цепи белка. 
• Кнопка  – при нажатой кнопке атомы водорода исключаются из 

отображения. 
 
Диалоговое окно “Residues”   (3.5.2. B) содержит список названий цепей с 

диапазонами отображаемых остатков каждой цепи. Для изменения диапазона 
нужно выделить название цепи с соответствующим диапазоном и нажать кнопку 
“Edit”. Появится диалоговое окно, заголовок которого будет содержать название 
цепи (например, “Chain: А”). В этом окне можно указать диапазон отображаемых 
остатков (рис. 3.5.3). Для изменения диапазона требуется ввести нужные 
значения в поля “From” и “To”. При нажатии кнопки “Set” на панели “Min” в поле 
“From” вводится номер первого остатка цепи. При нажатии кнопки “Set” на панели 
“Max” в поле “To” вводится номер последнего остатка цепи. 
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Списки выбора отображаемых элементов 

 
A 

 
 
 
 

B 

 
 

C 
 

D 

 
E 

Рисунок 3.5.2. 
A. Список выбора отображаемых атомов. B. Список выбора диапазонов остатков 
цепей.  C. Список выбора отображаемых цепей. D. Список выбора отображаемых 
химических элементов. E. Список выбора отображаемых моделей. 
 1. Кнопки выделения наборов атомов. 2. Строка статуса. 
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Диапазон отображаемых остатков цепи 

 
Рисунок 3.5.3. 

1. Поле “From”. 2. Поле “To”. 3. Панель “Min”. 4. Панель “Max”. 5. Кнопка закрытия 
окна и применения выбранных установок. 6. Кнопка закрытия окна и отмены 
выбранных установок.  
 
Кнопки управления диалоговым окном «Model options»: 

o Кнопка “OK” служит для выхода из окна и применения выбранных 
установок. 

o Кнопка “Cancel” служит для выхода из окна и отмены выбранных установок. 

3.6. Диалоговое окно настроек   
Диалоговое окно настроек “Options” (рис. 3.6.1) предназначается для настройки 

общих параметров отображения модели и степени чувствительности к движению 
мыши. Вызвать диалоговое окно настроек можно следующими способами: 

• Командой View>Options главного меню. 
• Кнопкой   панели управления. 

 
В нем можно изменить следующие параметры: 

• Расстояние до модели в поле “Model scale”.    
• Качество изображения в поле «Detail level».   Значение параметра «2» 

соответствует очень низкому качеству изображения, «5» - низкому, «15» - 
нормальному, «25» - высокому, «40» - очень высокому. 

• Чувствительность вращения к движению мыши в поле “Rotation speed   
• Чувствительность изменения расстояния до модели к движению мыши в 

поле “Scaling speed”.   
• Цвет фона областей отображения. Кнопка “Background” вызывает 

диалоговое окно выбора цвета “Color dialog”, с помощью которого можно 
установить нужный цвет. Работа с диалогом описана в п. 3.7. 

Примечание. Кнопка “OK” служит для выхода из окна и применения 
выбранных установок, кнопка «Apply» - для применения выбранных установок без 
закрытия диалогового окна, кнопка “Cancel” служит для выхода из окна и отмены 
выбранных установок. 
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Диалоговое окно настроек  

 
Рисунок 3.6.1. 

1. Расстояние до модели. 2. Качество изображения. 3. Чувствительность к 
движению мыши при вращении модели. 4. Чувствительность к движению мыши 
при изменении расстояния до модели. 5. Кнопка выбора цвета фона. 6. Кнопка 
закрытия окна и применения выбранных установок. 7. Кнопка закрытия окна и 
отмены выбранных установок. 8. Кнопка применения выбранных установок без 
выхода из окна. 

 
 

3.7. Диалоговое окно выбора цвета   
Диалоговое окно выбора цвета «Color dialog» (рис. 3.7.1) предназначено 

для выбора цвета. 
 Выбрать цвет можно несколькими способами. 

• Набор основных цветов. Необходимо щелкнуть мышью в одном из 
квадратов с нужным цветом набора основных цветов. На панели 
предварительного просмотра нового  цвета появится выбранный цвет. Для 
подтверждения выбора нужно нажать кнопку «OK» или «Apply». 

• Набор цветов пользователя. Необходимо щелкнуть в одном из квадратов с 
нужным цветом этого набора. На панели предварительного просмотра 
появится выбранный цвет. Для подтверждения выбора нужно нажать кнопку 
«OK» или «Apply». 

• Выбрать новый цвет. Для этого можно воспользоваться ползунком и 
переключателями и полями цветовой модели HSB, а также компонент 
цветовой модели RGB. Выбранный цвет появляется на панели 
предварительного просмотра нового цвета. Для подтверждения выбора 
нужно нажать кнопку «OK» или «Apply». 

• Если требуется вернуться к старому цвету, нужно щелкнуть мышью на 
панели предварительного просмотра предыдущего цвета и нажать кнопку 
«OK» или «Apply». 

Примечание. Набор цветов пользователя можно изменять. Для этого надо 
щелкнуть мышью на одном из квадратов набора цветов пользователя. Ползунком 
цвета, переключателями и полями моделей HSB и RGB  нужно выбрать желаемый 
цвет. После нажатия на кнопку «Set Custom Color» выбранный цвет появится в 
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указанном квадрате набора и на панели предварительного просмотра нового 
цвета. 

 
Диалоговое окно выбора цвета 

Рисунок 3.7.1. 
1. Селектор цвета. 2.  Ползунок. 3. Панель предварительного просмотра нового 
цвета. 4. Панель предварительного просмотра предыдущего цвета. 5. Цветовая 
модель HSB. 6. Цветовая модель RGB. 7. Набор цветов пользователя. 8. Набор 
основных цветов. 9. Кнопка для задания пользовательского цвета. 10. Кнопка 
закрытия окна и применения выбранных установок. 11. Кнопка закрытия окна и 
отмены выбранных установок. 12. Кнопка применения выбранных установок без 
выхода из окна. 

 
Кнопки управления диалоговым окном 

 Кнопка «Apply color» служит для применения сделанных изменений без 
закрытия диалогового окна, кнопка «OK» - при закрытии окна. Кнопка «Cancel» 
служит для отмены выбранных установок. 
 

 

3.8. Диалоговое окно отображения структуры в виде матричной 
диаграммы   

Диалоговое окно “Matrix” (рис. 3.8.1), предназначенное для отображения 
структуры молекулы в виде матричных диаграмм, вызывается кнопкой   панели 
управления. Цвет каждой ячейки на изображении зависит от значения 
соответствующего элемента матрицы. Тип матрицы может быть различным и 
выбирается пользователем. 

Списки выбора типов матрицы содержат по два варианта: 
• Distance  – отображается матрица расстояний между Cα−атомами. 
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• Identity  – отображается матрица сходства типов аминокислотных остатков. 
В строке статуса отображается информация о паре аминокислотных остатков, 

соответствующих положению курсора на матрице: расстояние между ними для 
типа “Distance” или их идентичность для типа “Identity”.  

На панелях общего и детализированного просмотра отображается отрезок, 
соединяющий Cα−атомы остатков, которые соответствуют положению курсора на 
матрице. 

Разметка слева и внизу матрицы соответствует вторичной структуре 
молекулы.  

Кнопка “Clone” предназначена для создания точной копии диалогового окна. 
 

Диалоговое окно “Matrix”  

 
Рисунок 3.8.1. 

1. Список идентификаторов моделей. 2. Кнопка копирования окна. 3. Список 
выбора типа матрицы вверху. 4.  Список выбора типа матрицы внизу. 5. Верхняя 
матрица. 6. Нижняя матрица. 7. Разметка вторичной структуры. 8. Строка статуса. 

3.9. Диалоговое окно выбора шрифта   
В диалоговом окне настроек шрифта (рис. 3.9.1) можно выбрать в 

соответствующих списках гарнитуру, стиль и размер шрифта. 
Выбранный шрифт отображается на панели предварительного просмотра 

«Preview». 
Примечание. Кнопка «OK» служит для закрытия окна и применения 

выбранных установок, кнопка «Apply font» - для применения сделанных изменений 
без выхода из диалогового окна. Кнопка «Cancel» служит для закрытия окна и 
отмены выбранных установок. 
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Диалоговое окно выбора шрифта 

 
Рис. 3.9.1. 

1. Список выбора гарнитуры шрифта. 2. Список выбора стиля шрифта. 3. Список 
выбора размера шрифта. 4. Панель предварительного просмотра шрифта. 
5. Кнопка закрытия окна и применения выбранных установок. 6. Кнопка 
применения изменений без выхода из окна. 8. Кнопка закрытия окна и отмены 
выбранных установок.  
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